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We have a brand new look! Take a tour with us and explore the latest updates on Adobe Support Community. ABHISHAMSTER a € ¢ Engaged, 28 Aug 2015 28 Aug 2015 HI ALLY1286, SAVE A COPY You need to change the form only when the module or saved as an extended PDF reader is distributed. In this case if you want to add the scroll function
to a field, then go to (in DC) 'Prepare Form' tool under the strumentiet on the right. On this screen, select the file and click Start. Double-click on the field and go to the 'Options' tab. Select the appropriate check box. Let me know if it works for you. How to jump to reply This document explains the properties of the PDF form field in Acrobat DC. (If
you are looking for more information about the properties of the module fields, click on the appropriate link above) Information about Form field properties How it behaves a form field is determined by the settings in the Property dialog box for that single field. You can set the properties that apply formatting, determine how module field information
refers to other module fields, impose limitations on what the user can enter in the module field, activate custom scripts, and so on . You can set various properties for an Acrobat form field, depending on the type of field shape. The properties for each type of shape field are selected on a series of cards. When you change a property, it is applied as
soon as you select another property or press ENTER. All types of shape fields have a general card and a stock card. Other cards appear only in specific types of form fields. The Options tab appears for most module field types, but the available options are unique for each type of shape field. Two items are available on each card. If you select one on
any card, a check mark will be displayed and the option will be controlled on all tabs. These are: Locked when selected, prevents further changes to any property field property. Close Closes the Property field module dialog. If you are changing the properties of multiple fields, you can leave the Property dialog box open. Click each field to change your
properties. If you select locked on any card, it locks all options for the field, not just options on that card. Changing the properties of the form field You can access the properties of the module field only when you are in editing mode. You can change the properties for more form fields at a time. If you are not in modification modification mode, choose
Tools> Prepare the form. Open the Property dialog using one of the following methods: To change a single shape field, double-click it or do With the right mouse button and choose properties. To edit multiple form fields, select the fields you want to change, right-click one of the selected fields and choose properties. Change the properties on each of
the available tabs, as needed. The property is changed as soon as you select another property or press ENTER. If you select form fields that have different property values, some options in the Property dialog box are not available. Otherwise, changes to the options available are To all fields of the selected module. To avoid accidental changes to the
module field, select Locked in the lower left corner of the Property dialog box before closing it. To unlock, click the option again. General tab For the properties of the form field The General tab appears for all types of module fields and includes the following options: Specify the unique name of the selected module field. View the text that the hesitant
user can find useful to fill out the form field. The suggestions appear when the pointer shakes briefly on the module field. Specifies if the module field can be seen, on the screen or in print. The choices are: visible, hidden, visible but print, and hidden but national but printable. Rotate the module field of 0, 90, 180 or 270 degrees prevents the user
from changing the contents of the module field. It forces the user to fill out the selected form field. If the user tries to send the form while a mandatory field is empty, an error message is displayed and the required Form Form field is highlighted. Appearance tab for field properties aspect field properties Determine how the module field looks on the
page. The Appearance tab is displayed for all types of module fields except barcodes and includes the following options: opens a color selector where you can select a color sample for the frame surrounding the field. To leave the field without a frame, select No color. Specifies the width of the frame surrounding the module field: subtle, medium or
often. Opens a color selector where you can select a color sample for the background behind the field. To leave the field non-flicker, select No Color. Note: a choice of different fill color from what no color will block all images on the PDF page that are behind the module field. Alter the appearance of the frame. Select solid, dashed, beveled, insert or
pointed out. Set the text size entered by the user or selection marker for radio buttons and check boxes. The choices include cars, various preset values and typing a different value. If you select Auto for a text field, such as user type, the font size changes to adapt to the text in the box. Opens a color selector where you can select a color sample for the
text or the selection marker. List the fonts available on your computer. This option is not available for form fields that do not display text. Enable the left-handed language options on the left in the language panel of the Preferences dialog box affects what is displayed on the Appearance tab of the Property dialog box. When this preference is selected,
the Appearance tab includes options for the digit style and text direction for text fields, drop-down list boxes and list boxes. Position card for the properties of the module field The Position tab allows you to position or size of the field or field currently selected on a accuracy of up to 10,000 inch. You can move the fields to the specified location on the
page. Use the height and width options to change only the size of the fields. To move fields without resize them, choose Don't change.And the width when the position changes. Card Options for Form Field Properties The options available on this tab change according to the selected form field type. The Options tab appears for all form field types
except digital signatures. The Options tab for barcode field properties contains the following: Includes barcode types PDF417, QR Code and Data Matrix. Note: If organizational processes are formed using multiple methods, select the method that houses images of lower quality barcodes. For example, if the modules are returned by fax and mail,
choose Fax Server as a decoding condition to ensure high reading rates on all modules. Compress data before encoding barcode Specifies that the data will be compressed before it is encoded. The data is compressed using the Flat compression method. Compressed data usually require less storage space in the barcode, allowing you to store more
data. In general, select this option if you use the Acrobat barcode decoder to interpret the returned data. Do not select this option if you use a portable barcode scanner, because most of these cannot decode compressed data. The preset decoding conditions represent the recommended starting points that you can adjust by clicking the custom button.
Opens a dialog box where you can select custom processing parameters which are best for specific scanning and fax hardware. (The available options vary according to barcode types.) Width, in miles (1 mil = 0.001 inches or 0.0254mm), of the cell. Height/width of the cell. For example, for a data cell that is twice as high as it is wide, insert 2.
(Available only for PDF417 barcodes.) Note: If you are planning to decode the barcode using a portable laser scanner, avoid creating bar codes larger than 4 inches (10.2 cm). The higher and tighter bar codes work better with portable scanners. The height and width of the barcode will not be a problem if you use an Adobe decoder for barcodes
(available separately). It matches the redundancy level of the data that is added to the barcode to fix potential decoding errors. Higher levels provide more redundancy and a stronger barcode that will generate more effective decoding results. However, the highest levels will also be translated into a broader barcode and a reduced ability to encode
the structure data provided by the user or to form the structure data in the barcode. A more robust bar code can reduce problems created by pen marks, poor print quality, degradation caused by transmissionor folds in the document. This option is available for PDF417 and QR Barcodes. Management of barcode parameters Saves custom barcode
selections to a file. You can then export the file and make it available to other form authors in your organization. Specifies the shape of the marker that appears within the check box when the user selects it: Check (the default), Circle, Cross, Diamond, Square or Star. This property does not alter the shape of the checkbox itself. Note: The size of the
marker inside inside inside Box is determined by the size of the specified character on the Appearance tab. Specifies a value to represent the item if the data will be exported. If empty on the left, the item by name in the General tab is used as an export value. Check box owed by default shows the selected check box less than the user deselect. For
both drop-down boxes or summary boxes, you use the Options tab to create a list of items from which the user selects. Although most of the properties of this card are common to both these types of module fields, some are exclusive of one type or another. Accept the text typed for the options you want to display in the menu for the field. Move the
current item in the item to the entry list. Where you type a value to represent the item if the data will be exported. If empty on the left, the item by name in the General tab is used as an export value. View the choices that will be available in the list. Note: The item highlighted in the Voice List box appears as the default element selected in the box or
list of drop-down box fields. To change the default item, highlight another element from the list. Change the order in which the entries are listed in the drop-down list. These buttons are not available if you select Order Voices. Removes the selected item from the list. Organize the items listed in alphabetical and numeric order. A numerical sort (where
appropriate) is performed before an alphabetical sort. Allow the user to enter the custom text (downhill only) allows users to enter a value other than those in the list. (Downhill only) controls the spelling of the text entered by the user. This option is applicable only if you allow the user to enter the text is selected Custom. (Only summary boxes) Allows
users to choose more than one entry in the list. Commit value Selected immediately saves the value, as soon as the user selects it. If this option is not selected, the value is saved only when the user tabs out of the current field or click on another module field. Only for summary boxes, this option is not available if multiple selection is selected. Create a
group of option buttons if you want the user to select only one choice between a series of choices. All a group selection buttons have the same name, but each key has a different value button. Specifies the shape of the marker that is displayed inside the button when the user selects: check, circle (the default), cross, diamond, square, or star. This
structure does not alter the shape of the radio button itself. Identify the option button and differentiate it from the other option buttons that The same name value. Button is selected by default groups the button selection status when the user opens the form first. Buttons with the same name and content are selected in the Unison Allows you to select
a single click more option buttons. For example, if the user selects a button that has the same field name and content selected as another, two option buttons are selected. Text fields accept user input, which can be being being Characters, numbers, or both. Align the text to the left, right or in the center of the field. Specifies the text that appears until
the user does not overwrite it by typing it in the field. Enter the default value by typing this option. It allows more than one single line in the text field. Compensate the text that extends beyond the text field boundaries. Allow Rich Text formatting allows users to apply stylistic information to the text, such as bold or italic. This could be useful in some
fields of text where such stylistic information is important for the meaning of the text, such as an essay. Allows the insertion of a maximum number of specified characters. If a predefined value has been entered, this value is reduced to this limit. View the text entered by the user as a series of asterisks (*). This option is only available if it is deselected
check spelling. Field used for selection of files Allows the user to enter a file path as the field value when a file is sent together with the form. This option is only available if long text scrolling is the only option selected in the Options tab. Check the spelling of the text entered by the user. Spread the text uniformly entered by the user over the width of
the text field. If a border color is specified in the Appearance tab, each font inserted in the field is separated from lines of that color. This option is only available if no other check box is selected. Text fields with and without the Comb A Property The actions you want to associate with the module field, such as switching to a specific page or playing a
multimedia clip. The Actions tab appears for all types of module fields and includes the following options: Specify the user action that starts an action: mouse up, Mouse Down, Mouse Enter, Mouse Exit, Focus or Blur. Specify the event that occurs when the user activates the action: Run a menu item, go to a 3D / Multimedia view, go to a page view;
Import module data, multimedia operation (Acrobat 9 and later), open a file, open a web link, Play a sound, Play supports (Acrobat 6 and later compatible), read an item, reset a form, run a JavaScript, set up The level visibility, show / hide a field, and send a form. Opens a window for the selected action. View the list of triggers and actions you have
defined. Change the order in which the selected action appears to appear below the trigger. (Only available if more actions have been defined for the same trigger.) Opens a dialog box with specific for the selected action. Removes the selected action or pair of actions. Calculate the form field property card The Calcium tab appears in the Properties
dialog boxes only for text fields and drop-down boxes. Use these options to perform mathematical operations on existing module field entries and view theSelect this if you want the user to type. Select this to make additional options available: list the mathematical functions to be applied to the selected fields. Choose SUM to add the values entered in
the selected fields, produced to multiply them, medium, minimum or maximum. Opens a dialog with a list of fields available in the module you select to add or deselect to remove from the calculation. Use JavaScript with field names and simple arithmetic signs. The Edit button opens a dialog box where you can write, edit and add scripts. Field names
are sensitive to chance. Custom calculation scripts View all custom scripts you added for calculations. The Edit button opens a dialog box where you can write and add new JavaScript. Set the form of calculation of the shape fields when defining two or more calculations in a form, the order in which they are carried out is the order in which the
calculations are defined. In some cases, you may need to change the calculation order to get correct results. For example, if you want to use the result obtained from the calculation of two shape fields to calculate the value of a third-shape field, the first two form fields must be calculated together first to obtain the correct final results. In the right
hand pane, choose more> Set the field calculation order. The Calculate fields dialog box displays all the calculable fields in the form and the order in which the calculations are performed. To change the field calculation order, select the field from the list, then click Up or Down button based on need. Acrobat automatically performs all the calculations
on the assigned field when creating and testing the module fields. For comfort, while working, it is possible to deactivate the automatic calculation in the preferres of the modules. Signed card for module field properties The signed tab is available only in the digital signature properties dialog. The selections made here determine what happens when
the user applies a digital signature to the module. Nothing happens when signed prevents further changes to the module signed digitally, according to the selection in the pop-up menu: prevents any changes to any shape field. Allows you to change only the selected module fields by clicking the PICK button and selecting the check boxes for the fields
you want the user to be able to change after the signature. It prevents changes only in the form fields you choose. This script runs when the field is signed active a custom JavaScript when the user digiparies the module. Use the Edit button to edit or create a new JavaScript action. Card format for the own properties of the field The Format tab
appears in the Property dialog box for only the text module or drop-down field fields. The options that are available depend on the selection in the Select Format Category pop-up menu. The example of the current format field shows a live preview of the settings. Additional options are available. The entrance to a text box or drop-down with this this
does not require any specific formatting. Automatically imposes the selected formatting options on the numerical data. Sets the number of digits appearing to the right of the decimal point. Sets the positioning of commas and periods. Sets the currency type, such as Euro, Dollars or Yen. Sets the position of the currency symbol in relation to the
number. This field is enabled if a currency symbol is selected. Sets how negative numbers are shown. You can choose Show brackets, Use red text, none or both. Automatically imposes the selected formatting options on numerical data expressed as a percentage. Set the number of digits to the right of the decimal point Set the placement of commas
and periods. The list includes the one-, two-, and four-digit variants, where d represents the day, m represents the month and y represents the year. The list includes display variants where h represents time on a 12-hour clock, H represents time on a 24-hour clock, MM represents minutes, ss represents seconds, and tt represents AM or PM. For a
five-digit American zip code. For a nine-digit American zip code. For a 10-digit phone number. For a nine-digit U.S. social security number. Dashes are inserted automatically after the third and fifth digits. Change the format category to Custom and make available another text field, where you can type a custom format. Use this option to specify which
character types the user can enter at a given location and how the data in the field is displayed. It only accepts letters (AAZ, a-z). It accepts spaces and most printable characters, including all characters available on a standard keyboard and ANSI characters in the ranges of 32A”126 and 128A”255. The letter “O” accepts alphanumeric characters
(AA¢A;Z, a-z and 0A¢A[9). It only accepts numeric characters (0A¢¢¢¢9). For example, a mask setting AAA--p#999 accepts BOE--p#767. A mask setting of 00O000@XXX accepts the vad12@3Up input. Example of an arbitrary mask entry Provides additional options for designers who want to write their own JavaScripts for formatting and typing keys.
For example, a custom script might define a new currency format or limit the useras insertion to specific keystrokes. View all the custom scripts you've added for the formats. The Edit button opens a dialog where you can write and add new scripts. View all the custom scripts you’ve added to validate keystrokes. The Edit button opens a dialog where
you can write and add new scripts. To obtain the JavaScript code for the Acrobat API Reference, please visit the Acrobat Developer Center at (Only in PDF). Validation tab For the properties of the module fields, the validation tab is displayed only in the Properties dialog boxes and drop-down box properties. Validation properties limit items at
specified intervals, values or characters, ensuring that users enter the appropriate data for a specified form field. Field field value Unvalidated Allows you to set a numerical range for module fields using the values entered as a number or percentage. Run Custom Validation Script Validates from a created or provided JavaScript. Value tab for module
field properties The Value tab appears only for the fields of the barcode module. Encode the data into the barcode in the standard XFDF format. The JavaScript script is generated automatically. Encodes fields in the barcode as tab-delimited values. The JavaScript script is generated automatically. If the form is configured to output data to individual
XFDF or XDP files, the data must be in a tab-delimited format with field names in the first line. This option is also useful if you want to enter more data into a barcode or if you want to copy the data into database tables or spreadsheets. Opens a dialog box where you select which user data fields will be encoded in the barcode to be recovered.
(Available only when Delimited tab encoding is selected.) Encode the field names as the first line of the barcode content. The values are coded below them. Custom calculation script Displays the default script. Click the Edit button to open the JavaScript Editor dialog, where you can write custom calculation scripts for the barcode. Reference to the
published formA" Show the path of the PDF form. You can change it by typing the URL of the published form. Afterwards, you can recreate a digital version of the completed form by joining the form template with a sample of user-provided data. It is also possible to maintain the relationship between a specific module template and its barcode data
files. When encoding a barcode using XML values, the URL reference is encoded in the barcode and displayed on the form below the barcode. A barcode type, with the URL reference below Manage custom barcode settings, you can save, reuse, and share a set of custom barcode settings, to be applied when creating new barcode module fields. You
can make further changes to the custom parameters after you have defined them. All these processes start by opening the properties dialog of the barcode form field. To open the Properties dialog, double-click the Barcode field. Create a new set of barcode parameters In the Properties dialog box barcode field, click the Options tab, then click Manage
barcode parameters. Select the existing parameter set you want to use as the basis of the new set and click New. Type a name in the Name and description in the Description box. Select the options for symbology, X size, Y / X ratio and error correction level, then click OK. The new set of parameters is displayed in the list in the Manage bar code
parameters dialog box and all the buttons on the right side of the dialog box become available. The new definition also appears in the decoding condition menu on the Options tab of the Property Bar Code field dialog. Edit or delete a set of custom parameters for barcodes in the Barcode Barcode field dialog box, click the tab options, and then click
Manage barcode parameters. Select a custom parameter set from the list. Choose the appropriate action: Click Edit and change the settings; Then click OK. Click Delete. Confirm the deletion in the message that appears by clicking OK. Export or import a set of custom bar code parameters in the barcode field properties dialog box, click the Options
tab, and then click Manage bar code parameters. Choose the appropriate action: Select a bar code parameter set from the list and click Export. Select a location and file name for the file that has the BPS file name extension Click Import and navigate and select the BPS file you want to import. Redefining the defaults of the module field property after
changing the properties for a certain type of shape field, you can set these properties as a predefined set for that type. For example, you can create a checkbox, change your properties and then save the properties as predefined values. The default values can only be for the related attributes Appearance and Size of the field. Property for attributes
related to format as data cannot be set as default. If necessary, choose Tools> Prepare. Form to go to module processing mode. Right-click the module field for which you have already changed property and choose using current properties as new defaults. Change the default properties Do not change the settings for existing form fields of that type.
The new defaults apply only to the new fields that are created. create.
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